
Internet Explorer 
Tổng quan về Internet 

Internet là một mạng máy tính toàn cầu trong đó các máy truyền thông với nhau theo một ngôn 
ngữ chung gọi là TCP/IP (Transmission Control Protocol/Internet Protocol), Không có máy tính nào làm 
chủ và điều khiển tất cả. 

Có nhiều dịch vụ khác nhau trên Internet, nhưng các dịch vụ phổ biến nhất đó là  
 WWW (World Wide Web): Cung cấp thông tin dạng siêu văn bản (Hypertext), kết hợp văn 

bản với hình ảnh, âm thanh và được liên kết với nhau giúp truy xuất nhanh thông tin. 
 E-mail (Electronic Mail-Thư điện tử): Gởi nhận thư điện tử trên Internet. 
 Usenet NewsGroup(Các nhóm tin): Khi bạn gởi thông điệp tới dịch vụ này thì mọi người trên 

Internet có thể đọc được nó và trả lời cho bạn  
 Chatting & Conferencing: Cho phép bạn tham gia thảo luận với nhau trên Internet. 

Hai dịch vụ lâu đời đó là: 
 FTP (File Transfer Protocol): Được dùng để tải các file lên máy chủ hay tải các file từ máy 

chủ xuống. 
 Gopher: Truy cập các tập tin trên Internet bằng hệ thống thực đơn đơn giản. 

Các dịch vụ mới đang phổ biến hơn khi công nghệ ngày càng phát triển, ví dụ như điện thoại, hội 
nghị qua Internet. 

Để kết nối vào Internet bạn cần có : 
 User Name và Password được cho bởi nhà cung cấp dịch vụ Internet (ISP)  
 Một Modem nối kết với đường dây điện thoại 

Ngoài ra, bạn cần có một chương trình, như Internet Explorer, gọi là « Trình duyệt Web » để có thể truy 
cập các dịch vụ trên Internet. 

Khởi động trình duyệt Internet Explorer: 
1. Click nút Start\ All Programs\ Internet 

Explorer  

2. hoặc bấm đúp vào biểu tượng Internet 

Explorer  trên Desktop (nếu có). 

3. Nếu chưa kết nối Internet sẽ hiện hộp 
thoại yêu cầu kết nối:  

4. Chọn một kết nối (Connection), rồi click 
nút Connect 

5. Nhập User Name và Password được cấp 
bởi nhà cung cấp dịch vụ, click nút Dial để 
quay số kết nối. 

Sau khi khởi động, trang chủ (Home page) 
mặc định của bạn xuất hiện, có thể là một 
trang trên World Wide Web hay trên Intranet 
cục bộ (có thể khác với hình trong sách). 
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Chọn một trang chủ (Home page) 
Trang chủ là trang mặc định được hiển 
thị khi bạn mở Internet Explorer. Bạn có 
thể thay đổi trang chủ theo các bước 
sau: 
1. Chọn Tools \ Internet options. Hộp 

thoại Internet options mở ra. 

2. Gõ địa chỉ trang chủ  vào ô Address. 

Ví dụ: 
http://www.dongnai.gov.vn/edu/  

3. Click nút OK, 

4. Click nút Home trên thanh công cụ 
Standard Buttons mỗi khi bạn muốn 
mở trang chủ. 
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Truy cập vào các Website khác trên Internet: 
Muốn truy cập vào WebSite hay trang Web nào, bạn có thể dùng các phương pháp sau: 

• Gõ địa chỉ trang Web vào thanh Address 
• Click vào một siêu liên kết (Hypelink) 
• Chọn một trang Web từ danh sách History 
• Chọn một site từ menu Favorites 
• Dùng thanh công cụ Links 
• Dùng Search Assistant 

Gõ địa chỉ trang Web vào thanh Address: 
Để đến một site nào trên Internet, bạn nhập địa chỉ của site đó vào ô Address, sau đó nhấn phím 

Enter hay click nút Go. 

 
Các địa chỉ trên Internet còn được gọi là URL (Uniform Resource Locators). Địa chỉ đầy đủ của 

một site trên internet có dạng như sau: Protocol://domain.name/path 
Ví dụ:  http://www.dongnai.gov.vn/edu 

 Nghi thức : http (Hypertext Transfer Protocol) 
 Domain.Name : www.dongnai.gov.vn 
 Path : edu 

Trong Internet Explorer, bạn không cần gõ http trong địa chỉ, ngoại trừ địa chỉ của site dùng giao 
thức khác, ví dụ FTP. Phần lớn bạn chỉ cần gõ địa chỉ bằng chữ thường, ngoại trừ một số địa chỉ có phân 
biệt chữ hoa chữ thường. 

Dùng các siêu liên kết 
Hầu hết các trang web đều 

chứa các siêu liên kết, dạng văn bản 
hay hình ảnh giới thiệu nội dung của 
một vị trí khác trên cùng trang web 
hoặc của trang web khác, giúp bạn 
chuyển nhanh đến vị trí hay trang web 
đó.  

Các siêu liên kết dạng văn bản 
thường có màu xanh da trời và được 
gạch chân. Ngoài ra khi bạn trỏ chuột 
vào văn bản hay hình ảnh của siêu liên 
kết thì con trỏ chuột đổi thành hình bàn 
tay đang trỏ. Khi đó, bạn chỉ cần click 
chuột vào đó để chuyển đến vị trí hay 
trang web được liên kết. 
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Trong trường hợp muốn 
trình bày các thông tin liên quan 
trên một cửa sổ mới thì Click 
mouse phải vào liên kết (link) và 
chọn chức năng Open in New 
Windows 
 

Chọn một trang Web từ danh sách History 
History là công cụ 
chứa danh sách các 
trang Web mới truy 
cập gần đây 
1. Click nút History 

trên thanh công cụ 
Standard Buttons 
để hiển thị khung 
danh sách History 

2. Click chọn thời 
điểm truy cập 

3. Click vào thư mục 
chứa các siêu liên 
kết đến các trang 
Web đã truy cập 
trước đó. 

4. Click siêu liên kết 
đến trang web cần 
truy cập. 

 

Chú thích: Để xóa các thông tin lưu 
trong History, bạn chọn: 
1. Tools\Internet Options… 

2. Click thẻ General 

3. Click nút Clear History 

4. Click nút Ok để đóng hộp thoại. 
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Chọn một site từ menu Favorites 
Favorites là nơi dành cho bạn lưu trữ lại địa chỉ của những site mà bạn thích. Vì vậy, bạn có thể 

truy cập đến các trang web này mà không cần nhớ và gõ lại địa chỉ của chúng. 

Để thêm địa chỉ trang web vào Favorites: 
1. Bạn mở trang web cần lưu 

địa chỉ vào Favorites. 

2. Ví dụ: Click hộp địa chỉ 
Address và gõ www.vnn.vn 

3. Chọn mục Favorites và 
chọn Add to Favorites… để 
mở hộp thoại Add 
Favorites 

4. Nhập tên gợi nhớ trong 
hộp Name (nếu muốn) 

5. Chọn Make available 
offline nếu bạn muốn tải 
trang Web xuống đĩa cứng 
để mở trong môi trường 
offline. 

6. Click nút Ok. 

 

 

Mở trang Web trong Favorites: 
1. Click nút Favorites trên thanh công cụ  

2. Click chọn tên trang Web đã lưu trong khung Favorites bên trái.  

Sử dụng các nút chức năng: 
• Nếu muốn quay trở lại trang trước: bấm 

nút Back 
• Nếu muốn tiến sang trang tiếp theo: bấm 

nút Forward 
• Trong lúc đang tải trang Web xuống, do 

chờ quá lâu, bạn muốn ngưng không tải 
nữa thì bấm nút Stop 

• Nếu bạn muốn tiếp tục tải xuống thì bấm 
nút Refresh 
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Lưu trữ thông tin: 
Trong khi duyệt thông tin, muốn lưu trữ lại các thông tin cần thiết ta thực hiện một trong những 

thao tác sau: 

Lưu trữ toàn bộ trang Web: 
1. Chọn Menu File/ 

Save As... 

2. Chỉ ra đường dẩn 
và nhập vào tên 
tập tin 

3. Click nút Save 

Lưu ý : Trong phần 
Save As Type nếu 
chọn Text File thì 
thông tin sẽ được lưu 
dưới dạng tập tin văn 
bản và có thể xem lại 
bằng bất kỳ một 
chương trình soạn 
thảo văn bản nào. 
Ví dụ: Word, 
Notepad...  
Ngược lại thì thông 
tin sẽ được lưu dưới 
dạng trang Web do 
đó khi xem lại phải 
xem bằng một trình 
duyệt Web. 

 

Lưu trữ 1 phần trang Web: 
Đôi khi, chúng ta không cần lưu toàn bộ trang Web mà chỉ quan tâm tới một phần nội dung của 

trang Web. Trong trường hợp này chúng ta mượn một chương trình xử lý văn bản để lưu trữ phần thông 
tin cần thiết. Các bước thực hiện như sau: 

1. Rê chuột để chọn phần văn bản cần lưu. 

2. Chọn chức năng Edit \ Copy trong thực đơn của Internet Explorer  
(hoặc nhấn tổ hợp phím Ctrl + C) 

3. Khởi động một chương trình soạn thảo văn bản (Word, Notepad, WordPad...) 

4. Chọn chức năng Edit/Paste trong thực đơn của chương trình soạn thảo văn bản (hoặc nhấn tổ 
hợp phím Ctrl + V) 

5. Lưu File trong chương trình soạn thảo văn bản.  

Lưu trữ hình ảnh: 
Khi lưu trữ các thông tin bằng 2 cách trên, chúng ta chỉ lưu trữ được các phần văn bản. Còn hình 

ảnh ta phải lưu theo cách sau: 
1. Click mouse phải vào hình 

2. Chọn chức năng Save Picture As...  Màn hình Save Picture xuất hiện  

3. Chỉ ra đường dẩn và nhập vào Tên tập tin 

4. Click nút Save 
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Tải xuống một tập tin (Download file): 
Nhiều trang Wed chứa các tập tin cho phép bạn tải xuống máy của mình. Thông thường, các trang 

web này chứa siêu liên kết có một đoạn văn bản kế bên cho biết đây là liên kết cho phép Download thông 
tin như: Click here to Download, Download, Download now..... hoặc tên tập tin. 
Thực hành: DownLoad một bài giảng mẫu trên trang Web của Sở GD và ĐT Đồng Nai 
1. Gõ địa chỉ trang Web trong 

hộp Address: 
www.dongnai.gov.vn/edu/  

2. Click mục Downloads dưới 
phần “Nội dung chính” 

3. Click liên kết “Bài giảng” 
bên khung phải 

 

 
4. Click liên kết PPT (chứa 

các file bài giảng mẫu được 
xây dựng bằng Powerpoint 
dạng nén ) 

5. Click chọn “Templates 
Pack 1” liên kết đến file 
cần chép về.  

6. Click vào liên kết Download 
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7. Click nút Save để lưu file 
vào đĩa. Khi đó sẽ hiện hộp 
thoại Save As.  

8. Bạn chọn nơi lưu trữ và 
nhập vào Tên tập tin (nếu 
cần) và Click nút Save. 

 

TÌM KIẾM THÔNG TIN TRÊN WEB 
Internet quá mênh mông nên việc tìm kiếm thông tin theo nhu cầu có thể mất nhiều thời gian. Do 

đó, nhiều công ty đã xây dựng các cơ chế tìm kiếm (Search Engine) trên Internet các trang web có chứa 
đoạn văn bản cần tìm. Internet Explorer dùng một chức năng gọi là Search Assistant cho phép bạn truy 
cập vào các trang web chứa công cụ tìm kiếm thông dụng. 
1. Click nút 

Search trên 
thanh công 
cụ để mở 
khung hổ trợ 
tìm kiếm 
thông tin 
(Search 
Companion) 

2. Gõ đoạn văn 
cần tìm trong 
hộp văn bản 
(không phân 
biệt hoa 
thường). 

3. Click nút 
Search để 
tìm kiếm.  

Các liên kết đến 
các công cụ tìm 
kiếm đoạn văn 
chỉ định sẽ hiển 
thị. 

4. Click mục Automaticcally send your search to 
other search engines.Để gởi yêu cầu tìm kiếm 
đến các trang Web chứa các công cụ tìm kiếm 
khác. 
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5. Chọn một 
công cụ tìm 
kiếm, ví dụ 
như Google 
Search, 
công cụ tìm 
kiếm này 
hiển thị các 
liên kết đến 
các trang 
web có chứa 
đoạn văn 
cần tìm. 

6. Click vào 
một liên kết 
để mở trang 
web. 
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DỊCH VỤ E-MAIL 
E-mail là gì? 

E-mail là một dịch vụ cho phép gởi / nhận thư điện tử trên Internet. Đây là một dịch vụ rất phổ 
biến. Dịch vụ này không đòi hỏi hai máy tính gởi và nhận thư phải nối trực tiếp (end to end) với nhau. 

Bạn có thể đăng ký thuê bao một tài khoản E-mail của nhà cung cấp dịch vụ hoặc sử dụng một 
chương trình E-mail miễn phí như Yahoo, Hotmail, Juno hay Xoom ... Trong giáo trình này, xin giới thiệu 
dịch vụ E-mail trên Website yahoo.com. 

Sử dụng e-mail miễn phí trên yahoo: 
Đăng ký hộp thư: 

1. Khởi động trình duyệt Internet Explorer 

2. Nhập vào địa chỉ : http://mail.yahoo.com trong hộp Address 

3. Click 
vào link 
Sign up 
now 

 

 
4. Ở trang 

liệt kê 
các điều 
khoản 
cam kết 
giữa 
người 
dùng và 
Yahoo, 
click vào 
link Sign 
up now 
ở mục 
Free 
Yahoo! 
Mail. 

 

 
5. Nhập các thông tin cần thiết bao gồm:  
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6. Click nút Submit this form để hoàn tất công việc đăng ký.  

 

Yahoo ID: Tên đăng ký sử dụng. 
Đồng thời cũng chỉ ra địa chỉ E - 
mail  
Ví dụ: người có tên Phạm Anh 
Tuấn có thể đặt là PTAnh, khi đó 
địa chỉ Email là : 
PTAnh@yahoo.com 
Password: Mật khẩu tương ứng 
với tên đăngký (Yahoo ID).  
Re-enter password: Nhập lại 
mật khẩu một lần nữa.  
Security Question: Câu hỏi sẽ 
được hỏi khi quên Password  
Ví dụ: bạn thích màu gì? 
Your Answer: Câu trả lời tương 
ứng với Security Question  
Ví dụ: màu xanh.  
Sau này, nếu có quên password 
thì Yahoo sẽ hỏi "Bạn thích màu 
gì?". Nếu trả lời "Màu xanh" thì 
Yahoo vẫn cho phép sử dụng E-
mail. 
Birth day: Ngày sinh. 
Current Email: địa chỉ E-mail 
khác, nếu có. 
First name: Tên. 
Last name: Họ và tên lót. 
 Language & content: Ngôn ngữ 
sử dụng. 
Zip/Postal Code: Mã vùng. 
Gander: Giới tính. 
Industry: Ngành nghề, lãnh vực 
hoạt động. 
Title: Nghề nghiệp, công việc. 
Specialization: Chuyên môn 
Enter the word ...: Nhập vào một 
từ xuất hiện ở bên dưới. 
 
Chú ý:  
Các thông tin không có chữ 
Optional bên cạnh thì bắt buộc 
phải nhập. 

7. Click nút I Accept. 

Nếu đăng ký thành công, sẽ xuất hiện màn hình Yahoo Mail. Ngược lại, tùy theo trường hợp sẽ có 
những thông báo lỗi tương ứng. Thông thường, các lỗi thường gặp là: Chưa đăng ký đủ thông tin, tên 
đăng ký bị trùng, password 2 lần nhập không giống nhau... trường hợp này phải đọc các thông báo lỗi 
(màu đỏ) và sửa lại cho thích hợp.  
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Mở hộp thư trên Yahoo: 
1. Khởi động trình duyệt Internet Explorer 

2. Nhập vào địa chỉ : http://mail.yahoo.com 
trong hộp Address 

3. Nhập Yahoo ID và Password 

4. Click nút Sign In. Hộp thư Yahoo Mail của bạn 
sẽ được mở ra. 

 

 
Đọc thư : 

1. Click vào thư 
mục Inbox 

2. Yahoo sẽ liệt 
kê tất cả các 
thư  hiện có ( 
Thư mới sẽ 
được in đậm) 

3. Click vào thư 
muốn đọc. 

 

   51



Soạn thảo và gởi thư : 
1. Click vào 

nút 
Compose. 

2. Nhập địa 
chỉ của 
người nhận 
thư 

3. Nhập nội 
dung thư. 

4. Click nút 
Send. 

 

 
Chú thích: 

 To: Địa chỉ người nhận. Nếu gởi cho nhiều người thì các địa chỉ cách nhau bởi dấu phẩy hoặc dấu 
chấm phẩy. 

 Cc (Carbon Copy): Địa chỉ của người nhận với tư cách tham khảo. Cũng giống như trường hợp 
To, nếu có nhiều địa chỉ thì mỗi địa chỉ cách nhau bởi dấu phẩy hoặc dấu chấm phẩy. 

 Bcc (Blind Carbon Copy): Giống như Cc, chỉ khác là các địa chỉ liệt kê ở đây sẽ không xuất hiện 
trong phần tiêu đề thông báo khi người nhận mở thư. 

 Subject: Chủ đề của bức thư. 
 Attachment: Những tập tin gởi kèm theo thư . 

Gởi kèm tập tin: 
 
1. Click vào liên kết Attach 

File 

2. Lần lượt click nút Browse 
để chọn các File cần gởi 
kèm theo thư. 

3. Click nút Attach Files 

 

4. Trong trang thông báo kết 
quả, Click nút Done 
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Sử dụng hộp thư thuê bao với Outlook Express 
OutLook Express, cũng như các chương trình E-mail client khác như Microsoft OutLook, 

Netscepe, Internet mail..., được sử dụng để truy cập hộp thư đăng ký ở trạm E-mail của nhà cung cấp dịch 
vụ Internet hay nhà quản trị hệ thống mạng trong cơ quan. 

Khởi động chương trình: 
Click nút Start \ All Programs \ OutLook Express 

 

Các thư mục trong Local Folders 
 Inbox: Folder chứa các thư nhận được. 
 Out box (Unsent message): Các thư đã được gởi nhưng chưa đến trạm thư POP3. 
 Sent Items: Chứa các thư đã được gởi đi.  
 Deleted Items : Chứa các thư bị xóa. 
 Drafts: Chứa các thư soạn xong (bản nháp). 

 
Nhận Và Đọc Thư 

1. Click nút  trên thanh công cụ, các thư mới sẽ được đưa vào folder Inbox. Để đọc các 
thư này, thực hiện các thao tác sau: 

2. Click chọn Folder Inbox ở hộp bên trái. Danh sách các thư nhận được sẽ xuất hiện bên phải. 

3. Để xem nhanh thư, click chọn 1 trong danh sách các thư nhận được. Nội dung thư sẽ xuất hiện trong 
phần bên dưới của cửa sổ.  
Để xem nội dung thư trong một cửa sổ riêng biệt, Double Click vào thư. Nội dung thư sẽ được trình 
bày trong một cửa sổ khác. 

Lưu ý: 
 Đề xem tất cả các thông tin của thư nhận được như :thời gian gửi, địa chỉ người gởi...., Click phải 

vào thư, sau đó chọn Properties. 
 Để lưu lại nội dụng thư dưới dạng một tập tin, chọn chứ năng File/Save As... 
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Xem tập tin gởi kèm 
Thư có tập tin gởi kèm có chỉ báo là biểu tượng "chiếc kẹp giấy". Bạn có thể mở hoặc lưu vào đĩa 
của bạn 

1. Trong màn hình 
Preview, click vào 
biểu tượng 
"Chiếc kẹp giấy" .  

2. Sau đó click vào 
Tên tập tin gởi 
kèm. 

3. Chọn Open để mở hoặc chọn Save 
to disk đễ lưu tập tin vào đĩa. 

 

Trả lời thư 
1. Chọn Thư trong danh 

sách. 

2. Click nút Reply  trên 
thanh công cụ. 

3. Nhập Nội dung trả 
lời. 

4. Click nút Send. 

Lưu ý:  
Nếu click nút 

Reply All thay vì Reply 
thì Outlook sẽ trả lời thư 
đến tất cả các địa chỉ 
trong trường To, CC, Bcc 
của thư nhận được. 
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Chuyển tiếp thư 
1. Chọn Thư trong danh sách. 

2. Click nút Forward trên thanh công cụ. 

3. Nhập Địa chỉ người nhận ( nếu có nhiều địa chỉ thì cách nhau bởi dấu phẩy hoặc chấm phẩy). 

4. Nhập nội dung thư. 

5. Click nút Send. 

Xoá thư: 
1. Chọn Thư cần xóa. 

2. Nhấn phím Delete. 

Lưu ý:  
 Khi xóa một thư, Outlook sẽ chuyển thư đó vào folder Delete Items. Do đó, muốn phục hồi lại thư 
đã xóa thì chỉ cần chuyễn thư đó về lại folder Inbox. 

 Để xóa toàn bộ thư trong folder Deleted Item ta chọn Folder Deleted Item, sau đó chọn chức năng 
Edit \ Empty Deleted Items' Folder. 

Sử dụng sổ địa chỉ (Address Book) 
Address Book là nơi lý tưởng để lưu lại những thông tin cần về một cá nhân hoặc một tổ chức. Nó 

giống như một sổ địa chỉ đặt biệt với chức năng lưu trữ, sắp xếp và tìm kiếm những thông tin liên quan 
đến một người.  Một số thao tác trên Address Book như sau: 

Thêm một người (Contact) vào sổ địa chỉ 
1. Click vào biểu 

tượng 

 trên 
thanh công cụ. 

2. Click File \ 
New Contact... 

 

3. Nhập các 
thông tin như: 
Họ tên, địa chỉ 
e - mail,... 

4. Click nút OK. 

Lưu ý:   
Khi nhận 

được một thư, nếu 
muốn thêm người 
gởi thư đó vào sổ 
địa chỉ thì click phải 
vào thư, sau đó 
chọn Add Send to 
Address Book. 
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Thay đổi thông tin của một người 
1. Trong màn 

hình sổ địa chỉ, 
Double click 
vào Tên của 
người muốn 
thay đổi thông 
tin. 

2. Thay đổi 
những thông tin 
cần thiết. 

3. Click OK. 

 

 
Lưu ý: Để xóa một người trong sổ địa chỉ, click chọn Người đó rồi nhấn phím Delete. 

Soạn Thảo Và Gởi Thư : 
1. Trên thanh công cụ Click nút Create 

Mail 

2. Nhập Địa chỉ người nhận trong hộp 
To: (Bạn có thể Click nút To: để 
chọn địa chỉ người nhận đã lưu 
trong Address Book)  

3. Nhập Chủ đề bức thư  trong hộp 
Subject 

4. Nhập Nội dung bức thư. 

5. Click nút Send. 

Ghi chú :  
 Nếu đang làm việc ở chế 
độ không trực tuyến 
(offline). Thư sẽ được 
đưa vào Folder Outbox. 
Các thư trong Folder này 
sẽ được tự động gởi đi 
khi hệ thống ở trạng thái 
trực tuyến (Online).  

 Để lưu lại bản thảo chọn 
File/Save. Thư đang 
soạn sẽ được đưa vào 
Folder Drafts.Trong 
trường hợp có nhiều 
Account mail thì khi gởi 
thư Outlook sẽ ghi địa 
chỉ của Account được 
đặt mặc định ( default).  
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Định dạng nội dung thư : 
Khi muốn định dạng nội dung thư như: chữ đậm, chữ nghiêng, chèn hình ảnh ... vào trong thư. 
1. Chọn Format/Rich Text (HTML) 

2. Sử dụng thanh định dạng để định dạng tương tự như trong Microsoft Word 

Chèn tập tin 
1. Click vào một vị trí bất kỳ 

trong màn hình soạn thảo 
thư. 

2. Click chọn menu  
Insert \ File Attachments... 

3. Chọn tập tin muốn gởi kèm 
(để chọn nhiều tập tin cùng 
lúc, sử dụng thêm phím 
Ctrl. 

4. Click nút Attach. Danh sách 
các tập tin gởi kèm sẽ được 
liệt kê trong phần Attach 

 

 

 

Chèn âm thanh 
1. Trong màn hình soạn thảo thư, click 

Format\Background\Sound... 

2. Click nút Browse để chọn tập tin âm thanh 
(*.wav, *.snd...). 

3. Nhập vào thời gian thực hiện bản nhạc 
trong mục Repeat setting. 

4. Click nút OK. 
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Chèn hình ảnh 
1. Trong màn hình soạn thảo 

thư, click Insert \ Picture... 

2. Click nút Browse chọn tập 
tin hình ảnh. 

3. Đặt các thông số: 

 Alignment: canh lề. 
 Border Thickness: độ 

dày đường viền. 
 Horizontal: khoảng 

cách từ 2 cạnh bên của 
hình tới văn bản. 

 Vertical: khoảng cách 
từ đỉnh và đáy của hình 
tới văn bản. 

4. Click OK. 
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Câu hỏi trắc nghiệm
1. Microsoft Windows là gì? là một : 

A. Chương trình xử lý văn bản. (Word 
processing Program). 

B. Chương quản lý cơ sở dữ liệu 
(Database). 

C. Hệ điều hành (Operating System). 
D. Chương trình đồ hoạ (Graphics Program). 

2. Windows sử dụng duy nhất nút trái của 
chuột. (đúng/sai?) 

3. Cách nào sau đây di chuyển con trỏ chuột 
tới vị trí nào đó trên màn hình? 
A. Ấn các phím mũi tên trên bàn phím. 
B. Di chuyển chuột cho tới khi con trỏ chuột 

trỏ tới vị trí đó.  
C. Di chuyển chuột cho tới khi con trỏ chuột 

trỏ tới vị trí đó và click nút trái chuột. 
D. Di chuyển chuột cho tới khi con trỏ chuột 

trỏ tới vị trí đó và click nút phải chuột. 
4. Một tổ hợp phím là : 

A. Ấn hai hoặc nhiều phím cùng lúc,  giống 
như ấn phím <Shift> và <Tab> cùng lúc. 

B. Một cách để khóa máy tính của bạn ngăn 
cản việc truy xuất trái phép. Để mở khóa, 
gõ lại tổ hợp phím của bạn. 

C. Dùng bàn phím kết hợp với chuột. 
D. Một kiểu đồ uống hổn hợp 

5. Để hiển thị thực đơn tắt (shortcut menu) 
cho một đối tượng, thực hiện như sau: 
A. Trỏ tới đó đối tượng và ấn <Ctrl> + <P>. 
B. Chạm đối tượng trên màn hình với ngón 

tay của bạn. 
C. Click đối tượng đó. 
D. Click phải đối tượng đó. 

6. Phím <F1> hiển thị phần trợ giúp về vấn đề 
mà bạn đang làm việc. (Đúng hoặc Sai?) 

7. Để khởi động một chương trình trong 
Windows XP, thực hiện như sau: 
A. Giả sử Program Manager đang mở, bấm 

đúp Program Group nơi chứa chương 
trình bạn muốn chạy, mà bấm đúp vào 
chương trình đó. 

B. Click nút Start, trỏ tới menu All Programs, 
click menu và submenu nào đó nơi chứa 
chương trình bạn muốn chạy, và click tên 
chương trình đó. 

C. Click nút Start, trỏ tới menu Run , click 
menu và submenu nào đó nơi chứa 
chương trình bạn muốn chạy, và sau đó 
click tên chương trình đó. 

D. Các cách trên đều không đúng. 
8. Thanh nhỏ liệt kê tên chương trình và nằm 

trên cùng một cửa sổ được gọi là : 
A. Thanh Windows (Windows bar). 
B. Thanh chương trình (Program bar). 
C. Thanh tiêu đề (Title bar). 
D. Phần cao nhất của đà ngang cửa sổ. 

9. Bạn khởi động chương trình xử lý văn bản 
ưa thích để gõ một bức thư, nhưng 
chương trình xuất hiện trong cửa sổ quá 
nhỏ để sử dụng. Làm thế nào để mở to 
(maximize) cửa sổ toàn màn hình? (Có thể 
chọn nhiều câu) 

A. Chọn Window → Full Screen từ menu 
B. Bấm đúp thanh tiêu đề của cửa sổ 
C. Click biểu tượng của chương trình trên 

taskbar. 
D. Click nút Maximize ở phía bên phải của 

thanh tiêu đề cửa sổ 
10. Bạn có thể mở hoặc phục hồi một cửa sổ 

thu nhỏ bằng cách click biểu tượng của nó 
trên TaskBar. (Đúng hoặc Sai?) 

11. Bạn có thể di chuyển cửa sổ tới một vị trí 
khác trên màn hình máy tính của bạn bằng 
cách rê nó từ : 
A. Thanh tiêu đề - Title bar. 
B. Thanh trạng thái - Status bar. 
C. Di chuyển bằng tay. 
D. Đằng sau đuôi. 

12. Bạn có vài chương trình mở cùng lúc—
Làm thế nào để chuyển qua lại giữa các 
chương trình này? (Có thể chọn nhiều câu) 
A. Khởi động lại chương trình—Click nút 

Start, trỏ tới menu All Programs, click 
menu và submenu nào đó hiện chứa 
chương trình bạn muốn chuyển tới, và 
click tên chương trình bạn muốn thấy. 

B. Click biểu tượng chương trình trên 
Taskbar. 

C. Click vào phần thấy được nào đó của cửa 
sổ mà bạn muốn xuất hiện lên trên. 

D. Đè phím <Alt> và gõ phím <Tab> để hiển 
thị danh sách tác vụ (Task list). Gõ phím 
<Tab> cho tới khi chương trình bạn muốn 
đã được chọn, sau đó nhả phím <Alt> 

13. Bạn có thể mở menu của chương trình 
bằng cách: (Có thể chọn nhiều câu) 
A. Click tên menu bằng chuột. 
B. gõ phím <Esc> và gõ ký tự gạch chân có 

trong tên menu. 
C. gõ phím <Alt> và gõ ký tự gạch chân có 

trong tên menu. 
D. Hãy nói “Máy tính, hãy mở menu (nêu rỏ 

tên menu ở đây)”. 
14. Làm thế nào để di chuyển điểm chèn 

(insertion point) trong WordPad? (Có thể 
chọn nhiều câu) 
A. Gõ các phím mũi tên trên bàn phím 
B. Di chuyển con trỏ chuột tới vị trí đặt điểm 

chèn, sau đó click nút trái chuột.. 
C. Chọn menu Window → Move Insertion 

Point. 
D. Điểm chèn là đối tượng không thể di 

chuyển được. 
15. Phím nào xoá văn bản ngay trước hoặc 

bên trái của điểm chèn? 
A. <Page Up> 
B. <Page Down> 
C. <Delete> 
D. <Backspace> 

16. Ký tự vừa gõ sẽ đè lên hoặc thay thế văn 
bản đã được chọn? (Đúng hoặc Sai?) 

17. Những phát biểu nào sau đây là sai?  
A. Bạn có thể phục hồi hành động cuối cùng 

hoặc lỗi lầm đã thực hiện bằng cách click 
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nút Undo trên thanh công cụ (toolbar) 
hoặc bằng cách chọn menu Edit → Undo. 

B. Bạn có thể in file đang làm việc bằng cách 
click the nút Print trên thanh công cụ hoặc 
bằng cách chọn menu File → Print. 

C. Bạn nên lưu công việc hoặc file của bạn 
vào một nơi nào đó mà bạn muốn. 

D. Tên File có thể hơn 8 ký tự. 
18. Hành động nào sau đây sẽ di chuyển (cut) 

văn bản hay thông tin được chọn và đặt 
vào clipboard (Có thể chọn nhiều câu) 
A. Nhấn <Ctrl> + <X>. 
B. Nhấn <Ctrl> + <Delete>. 
C. Click nút Cut trên thanh công cụ (toolbar). 
D. Chọn menu Edit → Cut. 

19. Không như di chuyển, khi bạn sao chép 
(copy) một đối tượng đó, bạn không thể 
thấy nó trên màn hình. (Đúng hoặc Sai?) 

20. Ấn <F5> sẽ hiển thị phần trợ giúp về vấn 
đề mà bạn đang làm việc. (Đúng hoặc Sai?) 

21. Máy tính lưu trữ thông tin trên loại đĩa 
nào? (Có thể chọn nhiều câu) 
A. Đĩa mềm - Floppy disks. 
B. Đĩa cứng - Hard disks. 
C. Đĩa CD - Compact discs (CD-ROMs). 
D. Đĩa Removable. 

22. Tên ổ đĩa có một ký tự. Hầu hết máy tính 
đều có một đĩa mềm gọi là (A:) và một đĩa 
cứng gọi là(C:). (Đúng hoặc Sai?) 

23. Mục đích của việc tổ chức thư mục trên 
máy tính là: (Select all that apply). 
A. Bỏ qua những file quan trọng của bạn. 
B. Lưu trữ chương trình và các file liên quan 

cùng một nơi. 
C. Gây khó khăn trong việc xóa dữ liệu trừ 

phi bạn hiểu rỏ bạn đang làm gì. 
D. Tổ chức các file và thông tin liên quan trên 

máy tính của bạn. 
24. .TXT, .DOC, và .BMP — Đây là tất cả các ví 

dụ về:  
A. Ba ký tự vô nghĩa với một dấu chấm phía 

trước. 
B. Các phần mở rộng của file (File 

extensions). 
C. Các mức độ cao cấp của máy tính. 
D. Sự phức tạp của máy tính. 

25. Chương trình nào bạn có thể dùng để xem 
và quan lý nội dung máy tính của bạn? (Có 
thể chọn nhiều câu) 
A. Netscape Navigator. 
B. My Computer. 
C. System Sleuth. 
D. Windows Explorer. 

26. Mở file hoặc folder bằng cách bấm đúp vào 
nó . (Đúng hoặc Sai?) 

27. Để hiển thị nội dung của ổ đĩa hoặc folder 
nào đó, thực hiện như sau: 
A. Click phải chuột vào ổ đĩa hoặc folder. 
B. Click ổ đĩa hoặc folder trong khi đè phím 

<Alt>. 
C. Bấm đúp vào ổ đĩa hoặc folder. 
D. Click 3 cái vào ổ đĩa hoặc folder. 

28. Để xem thuộc tính của một đối tượng, 
Click phải đối tượng và chọn Properties từ 
menu tắt. (Đúng hoặc Sai?) 

29. Khi bạn liệt kê nội dung máy tính, để di 
chuyển về thư mục cha, thực hiện như 
sau:. (Có thể chọn nhiều câu) 
A. Click nút Up trên thanh công cụ (toolbar). 
B. Click nút Back trên thanh công cụ. 
C. Nhấn <Ctrl> + <Z>. 
D. Click thanh Address trên toolbar và chọn ổ 

đĩa hay thư mục cần chuyển tới. 
30. Những phát biểu nào sau đây là sai? 

A. Bạn có thể di chuyển một file hoặc một 
folder đến vị trí mới bằng phương pháp 
kéo thả. 

B. Bạn có thể đổi tên một file hoặc folder 
bằng cách click phải nó, chọn Rename từ 
menu tắt, gõ tên mới và ấn <Enter>. 

C. Dấu cộng (+) kế bên folder trong Windows 
Explorer dùng biểu thị folder đó đã bị khóa 
và không thể hiệu chỉnh hoặc xóa  

D. Đè phím <Ctrl> trong khi kéo thả là hành 
động sao chép (Copy) thay vì di chuyển 

31. Xóa một file hoặc folder bằng cách click 
chọn nó, ấn phím <Delete> , và xác nhận 
xóa. (Đúng hoặc Sai?) 

32. Để chọn được nhiều files và folders?  
A. Click và rê hình chữ nhật bao quanh 

những files kề nhau cần chọn. 
B. Chọn File → Select Multiple Files từ 

menu, sau đó click những file cần chọn. 
C. Click vào file bạn muốn chọn, đè phím 

<Shift> và click vào tên file cuối cùng mà 
bạn muốn chọn. 

D. Đè phím <Ctrl> và click những files bạn 
muốn chọn. 

33. Những phát biểu nào sau đây là sai? 
A. Bạn có thể tìm file trên máy tính của bạn 

bằng cách click nút Start, chọn Search, 
nhập những gì bạn muốn tìm và click 
Search. 

B. Mở Windows Explorer bằng cách click nút 
Start và chọn All Programs → Windows 
Explorer. 

C. Lưu file vào vị trí khác với thư mục mặc 
định của chương trình, sau đó dùng My 
Computer hoặc Windows Explorer để di 
chuyển file tới vị trí mong muốn. 

D. Bạn có thể hiển thị nội dung ổ đĩa hoặc 
folder với Thumbnails, Tiles, Icons, List, 
hoặc Details. 

34. Phần mở rộng 3 ký tự của file được hiển 
thị bình thường trong Windows XP. 

(Đúng hoặc Sai?) 
35. Bạn có thể di chuyển Taskbar tới bất cứ 

cạnh nào của màn hình (Đúng hoặc Sai?) 
36. Những phát biểu nào sau đây là không 

đúng? 
A. Bạn có thể thay đổi kích thước Taskbar 

bằng cách rê cạnh trên Taskbar cho đến 
khi đạt kích cỡ mong muốn. 

B. Di chuyển con trỏ tới đáy màn hình để 
hiển thị taskbar khi taskbar đang ẩn. 

C. Bạn có thể đặt Taskbar ở giữa màn hình. 
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D. Bạn có thể thay đổi kích thước của 
Taskbar làm cho nó gần như biến mất 
khỏi màn hình. 

37. Bạn có thể điều chỉnh âm thanh máy tính 
của bạn bằng cách click nút Start → All 
Programs → Accessories → Entertainment 
→ Volume và rê con trượt lên hoặc xuống 
(Đúng hoặc Sai?) 

38. Những phát biểu nào sau đây là sai? 
A. Bạn không thể thêm hoặc xóa các chương 

trình từ Start menu. 
B. Hầu hết các chương trình tự nó thêm vào 

menu All Programs trong menu Start 
C. Xóa một chương trình từ Start menu sẽ 

xóa chương trình đó từ đĩa cục bộ của 
bạn. 

D. Bạn có thể mở lại các tài liệu mới mở gần 
đây bằng cách click nút Start, chọn My 
Recent Documents và chọn tên file cần 
mở. 

39. Bạn có thể tạo, đổi tên, xóa và di chuyển 
folder và file trong menu Start, giống như 
thực hiện trong : 
A. Windows Explorer. 
B. WordPad. 
C. máy tính Macintosh. 
D. Taskbar. 

40. Bạn biết một chương trình đã được cài đặt 
trên máy tính, nhưng vì lý do nào đó bạn 
không tìm thấy trong menu Start. Làm thế 
nào bạn có thể khởi động chương trình? 
A. Click nút Start, chọn Run, click the Browse 

nút, tìm và bấm đúp file đó. 
B. Mở My Computer, tìm file và bấm đúp nó. 
C. Mở Windows Explorer, tìm file và bấm đúp 

nó. 
D. Đọc tên chương trình 30 lần trong khi gõ 

nhẹ bàn phím với một xương gà 
 
41. Những phát biểu nào sau đây là sai? 

A. Các Shortcut có một ô chứa mũi tên trong 
góc của chúng. 

B. Khi bạn xóa một shortcut, thì sẽ xóa luôn 
những  file hoặc folder mà nó trỏ tới. 

C. Bạn có thể tạo một shortcut bằng cách rê 
file hoặc folder tới một vị trí mới với nút 
phải của chuột và chọn Create Shortcut 
Here từ menu tắt. 

D. Các mục trong menu Programs của menu 
Start đều là những Shortcut. 

42. Control Panel chỉ được sử dụng cho việc 
thiết lập mạng cao cấp, không dành cho 
người sử dụng bình thường. (Đúng hay 
Sai?)  

43. Những phát biểu nào sau đây là sai? 
A. Bạn có thể thay đổi hình thức hiển thị 

Windows kiểu cũ (Classic) nếu bạn không 
thích kiểu mới XP. 

B. Bạn có thể thay đổi màu cho các cửa sổ 
(Windows) bằng cách chỉ chọn một sơ đồ 
màu( color scheme). 

C. Bấm đúp đống hồ (clock) trên thanh 
Taskbar để hiệu chỉnh ngày giờ của máy 
tính. 

D. Bạn chỉ có thể dùng những mẫu có sẵn 
theo đúng giấy dán tường desktop 
(Desktop wallpaper) của bạn. 

44. 640 x 480, 800 x 600, 1024 x 768 là những ví 
dụ của: 
A. Các độ dày của màu. 
B. Ba kích cỡ hành lang lộ thiên rộng nhất 

trên thế giới. 
C. Độ phân giải màn hình (Screen 

resolutions). 
D. Những bài toán nhân mà bạn cần phải 

tính toán tìm lời giải. 
45. Bạn có thể thay đổi tốc độ bấm đúp của 

chuột bằng cách click biểu tượng Chuột 
trong phần Printers and Other Hardware 
của Control Panel. (Đúng hay Sai?) 

46. Sự khác nhau chủ yếu giữa Windows 95 và 
Windows XP là : 
A. Tên file trong Windows XP có thể dài tới 

256 ký tự thay vì chỉ 8 ký tự trong 
Windows 95. 

B. Windows XP đáp ứng với những lệnh phát 
bằng âm thanh.. 

C. Windows XP cho bạn chọn cách nhìn và 
làm việc với các nội dung của máy tính 
giống như trang Web. 

D. Windows 95 cần đến 8 MB bộ nhớ RAM 
trong khi Windows XP chỉ cần đến 2 MB 
bộ nhớ RAM. 

47. Bấm đúp vào desktop để mở hộp thoại 
Display Properties, cho phép thay đổi các 
thiết lập màn hình, như màu cửa sổ, độ 
phân giải màn hình, nền desktop. (Đúng 
hay Sai?) 

 
48. Chương trình WordPad có các đặt trưng 

sau: (Có thể chọn nhiều câu) 
A. Cho phép dùng các Font chữ khác nhau. 
B. Có chức năng kiểm tra lỗi chính tả (spell-

checker). 
C. Cho phép định dạng các đoạn 

(paragraphs). 
D. Có từ điển đồng nghĩa (Thesaurus). 

49. Chương trình NotePad có thể mở các file 
văn bản có kích thước bất kỳ? (Đúng hay 
Sai?) 

50. Để ghi âm thanh với Sound Record bạn sẽ 
cần: (Có thể chọn nhiều câu) 
A. Card âm thanh (sound card). 
B. Microphone. 
C. Giao diện MIDI (MIDI interface). 
D. Loa (Speakers). 

51. Chương trình Calculator có thể hiển thị ở 
chế độ chuẩn (standard) và chế độ khoa 
học (scientific) (Đúng hay Sai?) 

52. Trò chơi nào không là trò chơi của 
Windows XP? 
A. Solitaire. 
B. Minesweeper. 
C. Starcraft. 
D. FreeCell. 

53. Những phát biểu nào sau đây là không 
đúng? 
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A. Windows sẽ chơi tự động một đĩa nhạc 
khi bạn chèn nó vào ổ đĩa CD. 

B. Chương trình Character Map cho phép 
bạn chèn những ký hiệu đặc biệt không có 
trên bàn phím. 

C. Chương trình Paint lưu và mở các file 
JPG. 

D. Bạn có thể kích thước một hình vẽ. 
54. Nguồn video cho Windows Movie Maker 

không thể là: 
A. Magic “8” ball 
B. Máy quay video xách tay - Camcorder) 
C. WebCam 
D. Đầu máy Video - VCR 

55. Những phát biểu nào là không đúng về 
định dạng một đĩa mềm? 
A. Bạn phải thường xuyên định dạng đĩa 

mềm mới để lưu thông tin trên chúng. 
B. Bạn có thể sao chép các file hệ thống tới 

đĩa mềm, để sử dụng đĩa mềm đó khởi 
động máy tính của bạn. 

C. Việc định dạng đĩa mềm sẽ xóa tất cả 
thông tin trên đó. 

D. Nếu bạn định dạng đĩa mềm và Windows 
XP thông báo nó tìm thấy các sector xấu 
trên đĩa, bạn đừng lo nghĩ về nó, vì hầu 
hết đĩa mềm đều có sector hỏng. 

56. Bạn có thể sao chép đĩa mềm bằng cách 
chèn đĩa vào ổ đĩa, click phải vào biểu 
tượng ổ đĩa, và chọn Copy Disk từ menu 
tắt. (Đúng hay Sai?) 

57. Những phát biểu nào là không đúng về 
Error-checking? 
A. Bạn có thể quét đĩa theo cách chuẩn 

(standard) hoặc toàn diện (thorough) với 
Error-checking. 

B. Error-checking có thể tự động sửa chữa 
hầu hết các lỗi được tìm thấy trên đĩa. 

C. Error-checking sẽ tìm và xóa bất kỳ virus 
được tìm thấy trên đĩa. 

D. Quét toàn diện (thorough scan) đĩa cứng 
sẽ mất nhiều thời gian—trên vài giờ. 

58. Bằng cách click phải đĩa cứng, và chọn 
Properties, bạn có thể truy xuất tất cả các 
chương trình loại bỏ (EXCEPT) này? 
A. Error-checking. 
B. Drive Converter (FAT32). 
C. Disk Defragmenter. 
D. Disk Cleanup. 

59. Bạn là người bận rộn và có nhiều việc cần 
làm thay vì phải thực hiện việc bảo quản 
thường xuyên máy tính của bạn. Bạn có 
thể làm gì để hạn chế việc thực hiện bằng 
tay các chương trình Error-checking, Disk 
CleanUp, và Disk Defragmenter mỗi tuần. 
A. Thuê một ai đó để thực hiện công việc đó 

hộ bạn. 
B. Không dùng máy tính nữa. 
C. Thêm những chương trình này vào thư 

mục StartUp trong menu Programs. 
D. Thêm những chương trình này vào Task 

Scheduler. 
60. Cuối cùng, bạn đã mua được đĩa CD “Bird 

Watcher’s Encyclopedia” , mà bạn đã tìm 

kiếm suốt cả tháng qua. Làm thế nào để 
bạn cài đặt nó trên máy tính của bạn? 
A. Chèn đĩa CD vào ổ đĩa, Windows XP có 

thể tự động cài đặt nó. 
B. Chèn đĩa CD, mở My Computer, tìm file 

chương trình tên là "Setup", "Install", hoặc 
những tên tương tự, và bấm đúp vào file 
đó. 

C. Click phải trên thanh taskbar, chọn 
Properties từ menu tắt, click thẻ Start 
Menu Programs và click nút Add. 

D. Mở Control Panel, bấm đúp Add/Remove 
Programs, và click Install. 

61. Những phát biểu nào sau đây là sai? 
A. Bạn có thể xóa hầu hết các chương trình 

trên máy tính của bạn bằng cách mở 
Control Panel, bấm đúp Add/Remove 
Programs, chọn chương trình cần xóa, và 
click nút Add/Remove. 

B. Một thứ chứa trong đĩa CD-ROM 
Windows XP đều được cài đặt khi bạn cài 
Windows. 

C. Nhấn <Ctrl> + <Alt> + <Delete> mở cửa 
sổ Close Program, mà bạn có thể dùng để 
kết thúc một chương trình. 

D. Máy in mặc nhiên (defaul printer) là máy in 
mà Windows luôn luôn sử dụng để in, trừ 
khi bạn chọn máy in khác. 

62. Cổng (Port) máy in thường là COM1. (Đúng 
hay Sai) ? 

63. Các phát biểu nào sau đây là không đúng? 
A. Các máy tính có số lượng hạn chế các tài 

nguyên được sử dụng bởi các thiết bị 
phần cứng. Nếu 2 thiết bị phần cứng sử 
dụng cùng một tài nguyên thì sẽ bị xung 
đột phần cứng (hardware conflict). 

B. Windows XP tự động nhận diện và cài đặt 
bất cứ thiết bị phần cứng Plug và Play mà 
bạn đã gắn thêm khi mở máy tính. 

C. Bạn có thể dùng Add Hardware Wizard 
trong Control Panel để cài đặt thiết bị 
phần cứng nếu Windows XP không nhận 
diện được thiết bị đó. 

D. Các thiết bị được gọi là Plug và Play bởi 
vì bạn phải mất nhiều thời gian vận hành 
để bắt chúng làm việc.  

64. Một Web server là : 
A. Siêu máy tính lớn nhất thế giới chứa và 

chạy Internet 
B. Một máy tính lưu các trang Web và luôn 

luôn được kết nối với Internet 
C. Một máy tính hành động như một cổng nối 

(gateway) giữa mạng cơ quan của bạn và 
Internet 

D. Một người hầu bàn tại nhà hàng dành cho 
các con nhện (Spiders) 

65. Trang Home là trang Web đầu tiên mà bạn 
thấy khi bạn kết nối vào Internet. (Đúng 
hay Sai?) 

66. Nút nào trên thanh công cụ của Internet 
Explorer mang bạn trở về trang đã viếng 
trước đó. 
A. Home 
B. Stop 
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C. Refresh 
D. Back 

67. Các phát biểu nào sau đây là không đúng? 
A. Internet Explorer lưu những trang Web đã 

được viếng vào History trong thời gian 20 
ngày. 

B. Một công cụ tìm kiếm (Search Engine) cho 
phép bạn tìm những trang Web với những 
chủ đề mà bạn thích 

C. Eudora là một chương trình e-mail chạy 
trên hệ điều hành Windows XP. 

D. Bạn có thể download và lưu các hình ảnh 
từ một trang Web lên trên máy tính của 
bạn. 

68. Sau khi bạn viết xong bức thư trong 
Outlook Express, click nút Send trên thanh 

công cụ thì bức thư sẽ gởi ngay đến nơi 
nhận nó. (đúng hay sai?) 

69. Các phát biểu nào sau đây là không đúng? 
A. Khi bạn hồi âm một bức thư, Outlook 

Express chứa nội dung của bức thư đó để 
người nhận biết được bạn đã hồi âm bức 
thư nào của họ. 

B. Các thư E-mail có thể chứa các file hình 
và tư liệu gọi là attachments 

C. Bạn có thể gởi e-mail nặc danh lợi dụng 
vào Bcc (Blind Carbon Copy) 

D. Bạn có thể lưu các trang Web mà bạn 
viếng thăm thường xuyên trong Favorites 
của Internet Explorer  
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